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About the Grammar

This document defines the XML grammar FileMaker Developer uses to create XML formatted Database Design 

Reports. Refer to this grammar for proper construction of XML tags, for example, if you want to create a custom 

XSL document. For more information about Database Design Report, see the FileMaker Developer onscreen 

Help.

Note  UPPERCASE values (for example, SUMMARY) must be entered exactly as shown.

Table 1: Summary Tags

Tag Name Value Description

<Summary> Empty The top most parent node

<Summary><XMLFileType> SUMMARY Stores the type of the XML 

report file. This value is used 

by the XSL file to determine 

if we are in summary mode or 

report mode

<Summary><CreationDate> Any text string Contains the creation date of 

the report

<Summary><CreationTime> Any text string Contains the creation time of 

the report

<Summary><File> Empty

<Summary><File><Name> Any text string

<Summary><File><XMLReportFile> Any text string Contains the XML detail 

report file name
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<Summary><File><PasswordsCount> Any numeric value Shows the number of 

Passwords found in the 

database referenced under 

<Name> tag

<Summary><File><Table><FieldsCount> Any numeric value Shows the number of Fields 

found in the database/Table 

referenced under <Name> tag

<Summary><File><LayoutsCount> Any numeric value Shows the number of Layouts 

found in the database 

referenced under <Name> tag

<Summary><File><RelationshipsCount> Any numeric value Shows the number of 

Relationships found in the 

database referenced under 

<Name> tag

<Summary><File><ScriptsCount> Any numeric value Shows the number of Scripts 

found in the database 

referenced under <Name> tag

<Summary><File><ValueListsCount> Any numeric value Shows the number of 

ValueLists found in the 

database referenced under 

<Name> tag

Table 2: General Tags 

Tag Name Value Description

<File> Empty The top most parent node

<File><Name> Any valid filename Stores the name of the table 

that is being documented

<File><XMLFileType> REPORT Stores the type of the XML 

report file. This value is used 

by the XSL file to determine 

if we are in summary mode or 

report mode

<File><SummaryLink> Any valid xml file This value is used as a 

hyperlink so we can get to the 

summary overview report 

from any report file

Table 1: Summary Tags

Tag Name Value Description
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<File><CreationDate> Any text string Contains the creation date of 

the report

<File><CreationTime> Any text string Contains the creation time of 

the report

Table 3: Table Tags

Tag Name Value Description

<File><Table> Empty Table node (mainly a place 

holder for future use)

<File><Table><Name> Same as 

<File><Name>

To be forward compatible

<File><Table><ID> 1 To be forward compatible

Table 4: Field Tags

Tag Name Value Description

<File><Table><FieldCatalog> Empty The top most parent node 

for all fields info

<File><Table><FieldCatalog><Field> Empty The top most node for the 

current field info

<File><Table><FieldCatalog><Field><Name> Any value Stores the name of the field

<File><Table><FieldCatalog><Field><ID> Same as FieldIDs() calc 

function

Stores the id of the field

<File><Table><FieldCatalog><Field><DataType> Can have one of the 

following values: 

TEXT

NUMBER

DATE

TIME

BINARY_DATA

FURIGANA This is the data type of the 

field

Table 2: General Tags 

Tag Name Value Description



    
<File><Table><FieldCatalog><Field><FieldType> Can have one of the 

following values: 

EDITABLE

CALCULATED

SUMMARY Contains the nondata type 

of the field

<File><Table><FieldCatalog><Field><AutoEnterOptions> Empty The top most parent for all 

field AutoEnter Options. If 

no AutoEnter options were 

set, <AutoEnterOptions> 

and all its children nodes 

will not get generated.

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<EntryType>

Can have one of the 

following values: 

CREATION_TIME

CREATION_DATE

MODIFICATION_DATE

MODIFICATION_TIME

CREATOR_NAME

MODIFIER_NAME

SERIAL_NUMBER

PREVIOUS_DATA

CONSTANT_DATA Auto enter type

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<SerialNumber>

Empty Exists only if type is 

SERIAL_NUMBER

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<SerialNumber><NextValue>

Any value Serial value to be assigned 

to the field

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<SerialNumber><Increment>

Any positive numeric 

value

The serial field will be 

incremented by this value 

for every newly added 

record

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<ConstantData>

Any value Exists only if type 

CONSTANT_DATA , 

contains the constant data 

to enter

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<Calculation>

Empty

Table 4: Field Tags

Tag Name Value Description



    
<File><Table><FieldCatalog><Field><AutoEnterOptions>

<Calculation><AlwaysEvaluate>

Can have one of the 

following values: 

TRUE

FALSE

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<Calculation><Description>

<Description> and its children nodes are identical to those 

under Script Tags

Empty See Script Tags for more 

details

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<Lookup>

Empty

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<Lookup><Reference>

Refer to Field References for more details on <Reference> 

node and its subnodes content

Empty Reference to a field

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<Lookup><NoMatchCopyOption>

Can have one of the 

following values: 

DO_NOT_COPY

COPY_NEXT_LOWER

COPY_NEXT_HIGHER

USE_CONSTANT

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<Lookup><CopyConstantValue>

Any value

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<Lookup><CopyEmptyContent>

Can have one of the 

following values: 

TRUE

FALSE

<File><Table><FieldCatalog><Field><AutoEnterOptions>

<AllowEditing>

Can have one of the 

following values: 

TRUE

FALSE

<File><Table><FieldCatalog><Field><ValidationOptions> Empty The top most parent for all 

field Validation Options. If 

no validation options were 

set, <ValidationOptions> 

and all its children nodes 

will not get generated.

Table 4: Field Tags

Tag Name Value Description



    
<File><Table><FieldCatalog><Field><ValidationOptions>

<StrictDataType>

Can have one of the 

following values: 

NUMERIC

FOUR_DIGIT_YEAR

TIME_OF_DAY

<File><Table><FieldCatalog><Field><ValidationOptions>

<NotEmpty>

Can have one of the 

following values: 

TRUE

FALSE

<File><Table><FieldCatalog><Field><ValidationOptions>

<Unique>

Can have one of the 

following values: 

TRUE

FALSE

<File><Table><FieldCatalog><Field><ValidationOptions>

<Existing>

Can have one of the 

following values: 

TRUE

FALSE

<File><Table><FieldCatalog><Field><ValidationOptions>

<ValueList>

Empty

<File><Table><FieldCatalog><Field><ValidationOptions>

<ValueList><Reference>

Refer to ValueList References for more details on 

<Reference> node and its subnodes content

Empty Reference to a field

<File><Table><FieldCatalog><Field><ValidationOptions>

<Range>

Empty If exists, Range option is 

checked

<File><Table><FieldCatalog><Field><ValidationOptions>

<Range><From>

Any value

<File><Table><FieldCatalog><Field><ValidationOptions>

<Range><To>

Any value

<File><Table><FieldCatalog><Field><ValidationOptions>

<Calculation>

Empty

<File><Table><FieldCatalog><Field><ValidationOptions>

<Calculation><AlwaysValidate>

Can have one of the 

following values: 

TRUE

FALSE

Table 4: Field Tags
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<File><Table><FieldCatalog><Field><ValidationOptions>

<Calculation><Description>

<Description> and its children nodes are identical to those 

under Script Tags

Empty See Script Tags for more 

details

<File><Table><FieldCatalog><Field><ValidationOptions>

<MaxDataLength>

Numeric value between 1 

and 64000

This specifies the 

maximum number of 

characters for this field

<File><Table><FieldCatalog><Field><ValidationOptions>

<StrictValidation>

Can have one of the 

following values: 

TRUE

FALSE

<File><Table><FieldCatalog><Field><ValidationOptions>

<ErrorMessage>

Any value

<File><Table><FieldCatalog><Field><StorageOptions> Empty The top most parent for all 

field Storage Options

<File><Table><FieldCatalog><Field><StorageOptions>

<Repetitions>

Numeric value between 1 

and 1000

1 means not repeating

<File><Table><FieldCatalog><Field><StorageOptions>

<Global>

Can have one of the 

following values: 

TRUE

FALSE

<File><Table><FieldCatalog><Field><StorageOptions>

<Unstored>

Can have one of the 

following values: 

TRUE

FALSE Exists only for calcs

<File><Table><FieldCatalog><Field><StorageOptions>

<Indexed>

Can have one of the 

following values: 

TRUE

FALSE

<File><Table><FieldCatalog><Field><StorageOptions>

<AutoIndex>

Can have one of the 

following values: 

TRUE

FALSE

Table 4: Field Tags

Tag Name Value Description



    
<File><Table><FieldCatalog><Field><StorageOptions>

<IndexLanguage>

Can have one of the 

following values: 

Catalan

Danish

Dutch

English

Finnish

Finnish (v  w)

French

German

German (  = a)

Icelandic

Italian

Norwegian

Portuguese

Spanish

Spanish (New Style)

Swedish

Swedish (v  w)

Czech / Slovak

Hungarian

Polish

Romanian

Croatian

Turkish

Russian

Ukrainian

Greek

ASCII

<File><Table><FieldCatalog><Field><Calculation> Empty

<File><Table><FieldCatalog><Field><Calculation>

<AlwaysEvaluate>

Can have one of the 

following values: 

TRUE

FALSE

Table 4: Field Tags

Tag Name Value Description



        
<File><Table><FieldCatalog><Field><Calculation>

<Description>

<Description> and its children nodes are identical to those 

under Script Tags

Empty See Script Tags for more 

details

<File><Table><FieldCatalog><Field><SummaryOptions> Empty

<File><Table><FieldCatalog><Field><SummaryOptions>

<Operation>

Can have one of the 

following values: 

TOTAL

AVERAGE

COUNT

MINIMUM

MAXIMUM

STANDARD_DEVIATION

FRACTION_TOTAL

<File><Table><FieldCatalog><Field><SummaryOptions>

<Reference> 

Refer to Field References for more details on <Reference> 

node and its subnodes content

Empty Reference to a Field

<File><Table><FieldCatalog><Field><SummaryOptions>

<AdditionalOperation>

Can have one of the 

following values: 

RUNNING_TOTAL

WEIGHTED_AVERAGE

RUNNING_COUNT

BY_POPULATION

SUB_TOTALED

<File><Table><FieldCatalog><Field><SummaryOptions>

<SortedBy>

Empty

<File><Table><FieldCatalog><Field><SummaryOptions>

<SortedBy><Reference> 

Refer to Field References for more details on <Reference> 

node and its subnodes content

Empty Reference to a field

<File><Table><FieldCatalog><Field><SummaryOptions>

<WeightedBy>

Empty

Table 4: Field Tags

Tag Name Value Description
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<File><Table><FieldCatalog><Field><SummaryOptions>

<WeightedBy><Reference> 

Refer to Field References for more details on <Reference> 

node and its subnodes content

Empty Reference to a field

Table 5: Relationship Tags

Tag Name Value Description

<File><RelationCatalog> Empty The top most parent node for 

all Relations info

<File><RelationCatalog><Relation> Empty

<File><RelationCatalog><Relation><Name> Any value Store the name of the 

Relation that is being 

documented

<File><RelationCatalog><Relation><ID> Same number design 

function returns

<File><RelationCatalog><Relation><ParentField> Empty

<File><RelationCatalog><Relation><ParentField>

<Reference> 

Refer to Field References for more details on <Reference> 

node and its subnodes content

Empty Reference to a field

<File><RelationCatalog><Relation><ChildField> Empty

<File><RelationCatalog><Relation><ChildField>

<Reference> 

Refer to Field References for more details on <Reference> 

node and its subnodes content

Empty Reference to a field

<File><RelationCatalog><Relation><CascadeDelete> Can have one of the 

following values: 

TRUE

FALSE

Table 4: Field Tags
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<File><RelationCatalog><Relation><CascadeCreate> Can have one of the 

following values: 

TRUE

FALSE

<File><RelationCatalog><Relation><Sorted> Can have one of the 

following values: 

TRUE

FALSE

Table 6: ValueList Tags

Tag Name Value Description

<File><ValueListCatalog> Empty The top most parent node for 

all ValueLists info

<File><ValueListCatalog><ValueList> Empty

<File><ValueListCatalog><ValueList><Name> Any value Store the name of the 

ValueList that is being 

documented

<File><ValueListCatalog><ValueList><ID> Same number design 

function returns

Store the name of the 

ValueList that is being 

documented

<File><ValueListCatalog><ValueList><Source> Can have one of the 

following values: 

CUSTOM

LOCAL_FIELD

RELATED_FIELD

EXTERNAL_FIELD

EXTERNAL_VALUE

LIST

<File><ValueListCatalog><ValueList><CustomList> Set if CUSTOM

Table 5: Relationship Tags

Tag Name Value Description
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<File><ValueListCatalog><ValueList><PrimaryField> Set if LOCAL_FIELD, 

RELATED_FIELD, 

EXTERNAL_FIELD

<File><ValueListCatalog><ValueList><PrimaryField>

<Reference> 

Refer to Field References for more details on <Reference> 

node and its subnodes content

Empty Reference to a field

<File><ValueListCatalog><ValueList><SecondaryField> Set if also display  

checked in the UI

<File><ValueListCatalog><ValueList><SecondaryField>

<Reference> 

Refer to Field References for more details on <Reference> 

node and its subnodes content

Empty Reference to a field

<File><ValueListCatalog><ValueList>

<SortSecondaryField>

Set if also display  

checked. Can have one 

of the following values: 

TRUE

FALSE

<File><ValueListCatalog><ValueList><ValueList> Set if 

EXTERNAL_VALUE

LIST

<File><ValueListCatalog><ValueList><ValueList>

<Reference> 

Refer to ValueList References for more details on 

<Reference> node and its subnodes content

Empty Reference to a ValueList. This 

is a case where a ValueList 

depends on another ValueList

Table 7: Layout Tags

Tag Name Value Description

<File><LayoutCatalog> Empty The top most parent node for 

all Layouts info

<File><LayoutCatalog><Layout> Empty

Table 6: ValueList Tags

Tag Name Value Description



      
<File><LayoutCatalog><Layout><Name> Any value Store the name of the layout 

that is being documented

<File><LayoutCatalog><Layout><ID> ID of layout as returned 

by design function

<File><LayoutCatalog><Layout><Object> Empty

<File><LayoutCatalog><Layout><Object><Name> Empty

<File><LayoutCatalog><Layout><Object><Type> Can have one of the 

following values: 

FIELD

BUTTON

FIELD_AND_BUTTON

<File><LayoutCatalog><Layout><Object><FieldFormat> Can have one of the 

following values: 

TEXT_BOX

SCROLLABLE_TEXT

_BOX

POPUP_LIST

POPUP_MENU

CHECK_BOXES

RADIO_BUTTONS

<File><LayoutCatalog><Layout><Object><ValueList>

<Reference> 

Refer to ValueList References for more details on 

<Reference> node and its subnodes content

Will exist only if the 

current field format 

does reference/depend 

on a valuelist

<File><LayoutCatalog><Layout><Object>

<ValueListFormat>

Can have one of the 

following values: 

POPUP_LIST

POPUP_MENU

CHECK_BOXES

RADIO_BUTTONS

Table 7: Layout Tags

Tag Name Value Description
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<File><LayoutCatalog><Layout><Object><Reference> 

Refer to Field References for more details on <Reference> 

node and its subnodes content

Will exist only if the 

object is a field

<File><LayoutCatalog><Layout><Object><AllowEditing> Can have one of the 

following values: 

TRUE

FALSE

<File><LayoutCatalog><Layout><Object><Command> Any valid Script Step 

command

<File><LayoutCatalog><Layout><Object><Description> 

<Description> and its children nodes are identical to those 

under Script Tags

Empty See Script Tags for more 

details

Table 8: Script Tags 

Tag Name Value Description

<File><ScriptCatalog> Empty The top most parent node for 

all scripts info

<File><ScriptCatalog><Script> Empty

<File><ScriptCatalog><Script><Name> Any value Store the name of the Script 

that is being documented

<File><ScriptCatalog><Script><ID> ID returned by design 

function

<File><ScriptCatalog><Script><Step> Empty

<File><ScriptCatalog><Script><Step><Command> Any valid Script Step 

command

<File><ScriptCatalog><Script><Step><Description> Empty

<File><ScriptCatalog><Script><Step><Description>

<Chunk>

Any value

<File><ScriptCatalog><Script><Step><Description>

<Chunk><Reference>

This tag is generated only if 

<Chunk> content is a 

reference

Table 7: Layout Tags

Tag Name Value Description
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<File><ScriptCatalog><Script><Step><Description>

<Chunk><Reference><Type> 

Refer to Reference Tags for more details on <Reference> 

node and its subnodes content

Can have one of the 

following values: 

FUNCTION_REF

TABLE_REF

FIELD_REF

LAYOUT_REF

VALUELIST_REF

RELATIONSHIP_REF

SCRIPT_REF Describes the content of 

<Chunk> node

Table 9: Password Tags

Tag Name Value Description

<File><PasswordCatalog> Empty The top most parent node for 

all Passwords info

<File><PasswordCatalog><Password> Empty

<File><PasswordCatalog><Password><Name> Any value Store the name of the 

Password that is being 

documented

<File><PasswordCatalog><Password><Privileges> Empty

<File><PasswordCatalog><Password><Privileges>

<MasterAccess>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<BrowseRecords>

Can have one of the 

following values: 

TRUE

FALSE

Table 8: Script Tags 

Tag Name Value Description



    
<File><PasswordCatalog><Password><Privileges>

<BrowseRecords><Description> 

<Description> and its children nodes are identical to those 

under Script Tags

See Script Tags for more 

details

<File><PasswordCatalog><Password><Privileges>

<EditRecords>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<EditRecords><Description> 

<Description> and its children nodes are identical to those 

under Script Tags

Empty See Script Tags for more 

details

<File><PasswordCatalog><Password><Privileges>

<DeleteRecords>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<DeleteRecords><Description> 

<Description> and its children nodes are identical to those 

under Script Tags

See Script Tags for more 

details

<File><PasswordCatalog><Password><Privileges>

<CreateRecords>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<PrintRecords>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<ExportRecords>

Can have one of the 

following values: 

TRUE

FALSE

Table 9: Password Tags

Tag Name Value Description



    
<File><PasswordCatalog><Password><Privileges>

<DesignLayouts>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<EditScripts>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<DefineValueLists>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<ChangePassword>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<Override>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<IdleDisconnect>

Can have one of the 

following values: 

TRUE

FALSE

<File><PasswordCatalog><Password><Privileges>

<Menu>

Can have one of the 

following values: 

NORMAL

EDITING_ONLY

NONE

Table 9: Password Tags

Tag Name Value Description
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Table 10: Reference Tags

Reference 
Type

Tags <Type> Value

Field <Reference>

<Reference><Type> 

<Reference><Name> 

<Reference><ID> 

<Reference><TableName> 

<Reference><FileName> 

<Reference><RelationshipName> 

<Reference><Link>

FIELD_REF

ValueList <Reference> 

<Reference><Type> 

<Reference><Name> 

<Reference><ID> 

<Reference><FileName> 

<Reference><Link>

VALUELIST_REF

Relationships <Reference> 

<Reference><Type> 

<Reference><Name> 

<Reference><ID> 

<Reference><FileName> 

<Reference><Link>

RELATIONSHIP_REF

Scripts <Reference> 

<Reference><Type> 

<Reference><Name> 

<Reference><ID> 

<Reference><FileName> 

<Reference><Link>

SCRIPT_REF

Layouts <Reference> 

<Reference><Type> 

<Reference><Name> 

<Reference><ID> 

<Reference><FileName> 

<Reference><Link>

LAYOUT_REF

Files <Reference> 

<Reference><Type> 

<Reference><Name> 

<Reference><Link>

TABLE_REF

Function  <Reference> 

<Reference><Type> 

<Reference><Name>

FUNCTION_REF 
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